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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 
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A. Overview of the American Rescue Plan Act of 2021 

B. ASC Programming and Reporting for Extended Amortization 

C. ASC Programming and Reporting for Funding Minimum Segment Rate Relief 

D. References 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
A. Overview of the American Rescue Plan Act of 2021  

 
• ARP 2021 passed March 11, 2021, with 2 significant pension law changes for single employer DB 

plans  
 

o Extended Amortization 
 Change amortization period for new shortfall amortization payments from 7 

years to 15 years 
 Set all prior shortfall amortization balances and payments to zero 
 Default Effective Date – For plan years beginning after December 31, 2021 

• Early Opt-in Option – Plan sponsors can elect to use the Extended 
Amortization for plan years beginning after December 31, 2018 

 
o Minimum Funding Segment Rate Relief 

 Adds a 5% floor to the 25-year average calculation for the tiered minimum 
segment rates 

 Changes the corridor that applies to the calculated average for the tiered 
minimum segment rates 

 Default Effective Date – For plan years beginning after December 31, 2019 
• Opt-out Option – Plan sponsors can elect to defer the use of the revised 

minimum funding segment rates until the plan year beginning after 
December 31, 2021 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization 

 
• Extended Amortization Plan Specification fields on Values \ VALPPA screen 

 
o Storage for up to 15 years of Shortfall Amortization Payments (SAPs) 

 
o ARP 21 Relief 1st Val Date input field 

 
 Use this field for plans using the Early Opt-in Option 

 
Plan Specifications: Values \ VALPPA screen 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization (Continued) 

 
• How to Activate ASC Programming for Extended Amortization 

 
o For Plans using the Default Effective Date (PYB after 12/31/2021) 

 
 No entries or changes to Values \ VALPPA needed 

 
 Run Calculations > Valuation 

 
• PYB before 1/1/2022 will be calculated using the 7-year amortization 

period. 
• For the first PYB after 12/31/2021, all prior SAPs will be set to zero and 

removed from the Values \ VALPPA screen 
• Starting with the first PYB after 12/31/2021, the current shortfall 

amortization balance, if any, will be amortized using a 15-year period 
and stored in the Current Amortization Payment field in Values \ 
VALPPA screen 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization (Continued) 

 
• How to Activate ASC Programming for Extended Amortization (Continued) 

 
o For Plans using Early Opt-in Option 

 
 Enter Early Opt-in valuation date in ARP21 Relief 1st Val Date 

 
• IF the ARP21 Relief 1st Val Date is  before  the current Valuation Date 

 
o Verify any prior SAPs stored already use the 15-year 

amortization period.  There should be no SAPs stored that use 
the 7-year amortization period. 

o During Calculations > Valuation: 
 Prior SAPs, if any, are kept in the Values \ VALPPA 

screen 
 Current shortfall amortization balance, if any, will be 

amortized using a 15-year period and stored in the 
Values \ VALPPA screen 

 
• IF the ARP21 Relief 1st Val Date is  equal to  the current Valuation Date 

 
o No other action needed on the Values \ VALPPA screen 
o During Calculations > Valuation: 

 All prior SAPs, if any, are set to zero and removed from 
the Values \ VALPPA screen 

 Current shortfall amortization balance, if any, will be 
amortized using a 15-year period and stored in the 
Values \ VALPPA screen 

 
• IF the ARP21 Relief 1st Val Date is  after  the current Valuation Date 

 
o Verify any prior SAPs stored still use the 7-year amortization 

period. 
o During Calculations > Valuation: 

 Prior SAPs, if any, are kept in the Values \ VALPPA 
screen 

 Current shortfall amortization balance, if any, will be 
amortized using a 7-year period and stored in the 
Values \ VALPPA screen 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization (Continued) 

 
• How to Activate ASC Programming for Extended Amortization (Continued) 

 
o For Plans using Early Opt-in Option (Continued) 

 

Description of  
Opt-in Scenarios 

ARP21 Relief 1st Val Date 
is before the current 
Valuation Date 

ARP21 Relief 1st Val Date 
is equal to the plan’s 
current Valuation Date 

ARP21 Relief 1st Val Date 
is after the current 
Valuation Date 

    
Plan Maintenance 
in Values \ VALPPA 
screen 

• Prior SAPs use 15-
year amortization 
period 

• No action needed • Prior SAPs use 7-
year amortization 
period 

    
Calculations > 
Valuation Results 

• Prior SAPs retained 
• Current SAP, if any, 

uses 15-year 
amortization period 

• Prior SAPs set to 
zero 

• Current SAP, if any, 
uses 15-year 
amortization period 

• Prior SAPs retained 
• Current SAP, if any, 

uses 7-year 
amortization period 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization (Continued) 

 

• How to Activate ASC Programming for Extended Amortization (Continued) 
 

o For Plans using Early Opt-in Option (Continued) 

Calculations 
> Valuation 
Results 

ARP21 Relief 1st 
Valuation Date in   

2019 

ARP21 Relief 1st 
Valuation Date in 

2020 

ARP21 Relief 1st 
Valuation Date in 

2021 

ARP21 Relief 1st 
Valuation left blank 

     

Valuation 
Date in 2019 

• Old Bases Set to 
Zero  

• 15-year period  
used for new 
Current Base 

• Old Bases 
Maintained 

• 7-year period 
used for new 
Current Base 

• Old Bases 
Maintained 

• 7-year period 
used for new 
Current Base 

• Old Bases 
Maintained 

• 7-year period 
used for new 
Current Base 

Valuation 
Date in 2020 

• 15-year period  
used for new 
Current Base 

• Old Bases Set to 
Zero 

• 15-year period 
used for new 
Current Base 

• Old Bases 
Maintained 

• 7-year period 
used for new 
Current Base 

• Old Bases 
Maintained 

• 7-year period 
used for new 
Current Base 

Valuation 
Date in 2021 

• 15-year period 
used for new 
Current Base 

• 15-year period 
used for new 
Current Base 

• Old Bases Set to 
Zero 

• 15-year period 
used for new 
Current Base 

• Old Bases 
Maintained 

• 7-year period 
used for new 
Current Base 

Valuation 
date in 2022 

• 15-year period 
used for new 
Current Base 

• 15-year period 
used for new 
Current Base 

• 15-year period 
used for new 
Current Base 

• Old Bases Set to 
Zero 

• 15-year period 
used for new 
Current Base 

 

Color 
Key 

ARP21 Relief 1st Val Date 
is before the current 
Valuation Date 

ARP21 Relief 1st Val Date 
is equal to the plan’s 
current Valuation Date 

ARP21 Relief 1st Val Date 
is after the current 
Valuation Date 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization (Continued) 

 
• ASC Reporting for Extended Amortization  

 
o When the 15-year method applies: 

 Actuarial Certification will refer to the American Rescue Plan Act of 2021 
 Shortfall Amortization Report will document the 15-year method in the 

Amortization Method column and remaining future installments based on the 
15-year amortization method in the Number of Future Installments column 

 
o Short Plan Year report will reflect the 15-year method as well, when applicable 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization (Continued) 

 
• ASC Reporting for Extended Amortization (Continued) 

 
o Sample Plan’s 1st year Shortfall Amortization report with Extended Amortization 

 

 
 

o Sample Plan’s 2nd year Shortfall Amortization report with Extended Amortization 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization (Continued) 
 

• Using ASC Table Maintenance Function Calc PV Factors to check Current SAP 
 

o Plan Data 
 Shortfall Balance for Minimum (Values \ VALPPA screen) – 96,909 

• This is the first year of ARP2021, so no reduction for prior SAP present 
values needed 

 Minimum Funding Segment Rates (Funding \ PPAFASMP screen) – 4.75% / 
5.50% / 6.27% 

 
o Launch Table Maintenance > Functions > Calc PV Factors 

 Use any mortality table 
 Enter tiered segment rates 
 Enter any Current and Retirement age, but they must be equal 
 Enter 15 in Period Certain 
 Check Certain Only option 
 Check Annual Rate option 
 Calculate PVF Result = 127.8137 (Annual) 

 
o Current SAP Calculation  

 Shortfall Balance for Minimum / [ Calc PVF Result (Annual) / 12 ] 
 96,909 / [127.8137 / 12 ] = 9,098.46 

 
Table Maintenance: Functions \ Calc PV Factors 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
B. ASC Programming and Reporting for Extended Amortization (Continued) 
 

• Using ASC Table Maintenance Function Calc PV Factors to check Value of Future Installments for 
prior SAPs 

 
o Plan Data 

 1 yr ago SAP (Values \ VALPPA screen) – 9,098.46 
 Number of Future Installments – 14  
 Minimum Funding Segment Rates (Funding \ PPAFASMP screen) – 4.50% / 

5.25% / 6.00% 
 

o Launch Table Maintenance > Functions > Calc PV Factors 
 Use any mortality table 
 Enter tiered segment rates 
 Enter any Current and Retirement age, but they must be equal 
 Enter 14 in Period Certain 
 Check Certain Only option 
 Check Annual Rate option 
 Calculate PVF Result = 123.7901 (Annual) 

 
o Value of Future Installment for 1 yr ago SAP 

 1 yr ago SAP x Calculate PVF Result (Annual) / 12 
 9,098.46 x 123.7901 /12 = 93,858 

 

 
Table Maintenance: Functions \ Calc PV Factors 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
C. ASC Programming and Reporting for Funding Minimum Segment Rate Relief 

 
• Minimum Funding Segment Rates in Table Maintenance \ Defined Benefit \ Segment Rates 

 
o HATFA rates (BBA 2015), the ‘F’ series tables, will phase out after December 31, 2021 

 
o ARP21 rates are the ‘G’ series tables 

 YYYYMMG0 – ARP21 Funding Rates for Plan Years beginning in 2020 
 YYYYMMG1 – ARP21 Funding Rates for Plan Years beginning in 2021  
 YYYY is the Year and MM is the month of publication 

 

 
Table Maintenance: Defined Benefit \ Segment Rates 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
C. ASC Programming and Reporting for Funding Minimum Segment Rate Relief 

(Continued) 
 

• How to Activate ASC Programming for Minimum Funding Segment Rate Relief 
 

o For Plans using the Default Effective Date (PYB after 12/31/2019) 
 Select ARP 2021 Minimum Funding Segment Rates in the Funding \ PPAFASMP 

screen  
 Run Calculations > Valuation 

• Check ‘Calculate Effective Interest Rate (EIR)’ option 
 Run Calculations > Actuarial > Quarterly Interest to reflect updated EIR 

 
o For Plans using Opt-Out Option (PYB in 2020 or 2021) 

 Select BBA 2015 Minimum Funding Segment Rates in the Funding \ PPAFASMP 
screen  

 Run Calculations > Valuation 
• Check ‘Calculate Effective Interest Rate (EIR)’ option 

 Run Calculations > Actuarial > Quarterly Interest to reflect updated EIR 

 

 

 

 

 

 

 

 

 

 

Plan Specifications: Funding \ PPAFASMP screen 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
C. ASC Programming and Reporting for Funding Minimum Segment Rate Relief 

(Continued) 
 

• ASC Reporting for Minimum Funding Segment Rate Relief 
 

o When the ARP 2021 Minimum Funding Segment rates are selected, the Actuarial 
Certification will refer to the American Rescue Plan Act of 2021 
 

o The Summary of Actuarial Assumptions, PPA Funding Values, and SB Information reports 
will reflect the ARP 2021 rates selected.  
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#1 – American Rescue Plan Act of 2021 

 
D. References  

 
• FAQs 

 

FAQ 910: PPA Shortfall Amortization Base - Funding Relief for ARP21 or PRA 2010 
FAQ 833: PPA/ARP Shortfall Payment Calculation using Segment Rates 
FAQ 906: PPA/ARP Shortfall Payment Calculation using Yield Curve Rates 
FAQ 977: Segment Rates - HATFA/BBA15/ARP21 

 
• DB Reference Manual 

 
• Online Help 

o <F1> on keyboard to access online help for each employee or plan specifications field 
 

• Update from Actuaries article 
o Update from Actuaries: American Rescue Plan Act of 2021 
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https://csc.asc-net.com/ProjectsBasket/CSC/faqNew/articles/Defined%20Benefit/FAQ833_PPAARP_Shortfall_Payment_Calculation_using_Segment_Rates.htm
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https://www.asc-net.com/actuarial-update-2021/
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
Topic Roadmap 

A. Overview 

B. Case Preparation  

C. Budget Calculations 

D. Analysis and Reporting 

E. References 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
A. Overview  

 
• First stage development of budget solving proposal programming and reports for cash 

balance/DC combo plans. 
 

• Advantages  
o Incorporates minimum required, maximum deductible, and 415 maximum lump sum 

calculations all within stated budget constraints 
o 415 adjustments for pre-62 or post-65 commencement is automated 
o Reflects published segment rates or rates selected that represent long-term budget 

planning 
o Use features within the ASC Valuation system plan specifications to further customize 

cash balance and DC plan calculations for the budget 
o Export results into your own custom proposal materials  
o Quickly convert finalized proposal case to a working valuation case 

 
• Considerations  

o Results should always be reviewed an actuary  
o Once budget results are calculated, you can adjust the final Cash Balance formula to fit 

your client’s goals 
o The combo plan in ASC is meant for use for budget proposal purposes.  It may not be 

appropriate for valuation purposes. 
o Current version of the budget calculator is designed for one person plans only.  

 
• Stay tuned for future enhancements! 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
B.  Case Preparation  

 
• Plan Specifications  

 
o New EOY valuation Cash Balance plan paired with a new DC plan 

 DB: Funding \ FUNDMETH screen \ Beginning of Year Valuation set to No 
 

o EOY valuation funding segment rates may not be published when you are preparing 
proposals 
 Work with your actuary to determine reasonable best estimate of segment 

rates 
 

o If Budget target is the Maximum Deductible, consider coding at-risk loads and 
assumptions 

 

  
DC Plan Specifications: General \ Identification \ ID screen 

 
DB Plan Specifications: General \ Identification \ ID screen 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
B. Case Preparation (Continued) 

 
• Employee Data  

 
o One participant in each plan 

 
o Index solo participant by coding the same value in SSN field or Name field  

 
o Solo participant Principal code setting 

 Cash Balance Plan: 1 – Group 1  
 DC Plan: Y – Yes  

 
o Deferral is an optional input in the DC plan 

 

 
DC Employee: Basic Data \ NAME screen 

 

 
DB Employee: Basic Data \ NAME screen 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
C. Budget Calculations 

 
• Launch from the DC: Calculations > Budget > DC/CB Combo Budget  

 

 
DC: Calculations > Budget > DC/CB Combo Budget Menu 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
C. Budget Calculations (Continued) 

 
• Menu Features 

 
o Multiple Plan Setup 

 Ensure Cash Balance plan is selected to be paired with the DC plan 
 Select option for indexing solo participant – either Number, Name or SSN 

 
o Valuation Options 

 If eligibility has not already been calculated in both plans, select ‘Calculate 
Eligibility’ option 

 
o Budget  

 Budget Amount  
• Leave blank to target the maximum deductible contribution 
• Input an amount to target a specific total budget for the combined 

CB/DC plans 
 Budget include deferrals – if checked, be sure deferrals are coded in DC 

employee record 
 

o Solving Options 
 Reserved for future enhancements 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
D. Analysis and Reporting 

 
• Review results within the CB and DC plan specifications and employee records 

 
• Customizable combo proposal report  

 
o Launch from the DC: Reports > Studies and Proposals > DC/CB Combo 

 
DC: Reports > Studies and Proposals > DC/CB Combo Menu 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
D. Analysis and Reporting (Continued) 

 
o Menu Options  

 
 Multiple Plan Setup 

• Ensure Cash Balance plan is selected to be paired with the DC plan 
 Report Sections 

• Title Page 
o Includes Disclaimer 

• Plan Summary 
o Summary of DC and CB plans 
o Budget conditions from Budget Calculations menu 

 

 
DC: Reports > Studies and Proposals > DC/CB Combo Menu: Plan Summary 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
D. Analysis and Reporting (Continued) 

 
o Menu Options (Continued) 

 
 Report Sections (Continued) 

 
• Summary of Assumptions 

o Summary of Cash Balance assumptions 

 
DC: Reports > Studies and Proposals > DC/CB Combo Menu: Summary of Assumptions 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
D. Analysis and Reporting (Continued) 

 
o Menu Options (Continued) 

 
 Report Sections (Continued) 

 
• Census 
• DC Plan Costs 

o Contributions, deferrals (if any), and totals 
• CB Plan Costs 

o Summarizes CB Contribution Credit, PPA Minimum, PPA 
Maximum, and 415 Immediate Maximum Lump Sum 

 

 
DC: Reports > Studies and Proposals > DC/CB Combo Menu: CB Plan Costs 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
D. Analysis and Reporting (Continued) 

 
o Menu Options (Continued) 

 
 Report Sections (Continued) 

 
• Combo Plan Costs 

o Summarizes the CB Contribution Credit, the DC Employer 
Contribution, CB Plan Costs, and Combined Plan Costs 

 
 

 
DC: Reports > Studies and Proposals > DC/CB Combo Menu: Combo Plan Costs 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
D. Analysis and Reporting (Continued) 

 
o Menu Options (Continued) 

 
 Report Sections (Continued) 

 
• Combo Plan Budget Summary 

o Cash Balance Funding Range 
 May result in no cash balance plan if the budget is 

satisfied by a solo DC plan 
o Combined Plan Maximum Deduction Limit 

 Reflects combined plan deduction limits 
o Budget Analysis 

 Provides analysis on the combined plan costs with the 
stated budget constraint 

 

 
DC: Reports > Studies and Proposals > DC/CB Combo Menu: Combo Plan Budget Summary 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
D. Analysis and Reporting (Continued) 

 
o Menu Options (Continued) 

 
 Report Sections (Continued) 

 
• Owner Summary 

o Includes estimated tax savings based on Tax Bracket entered in 
Report Options 

 Source Options 
 Employee Matching 

• Use Number, Name, or SSN field 
 Ownership Type 
 Plan Description 

• Edit the title of the plan that appears on the Title Page and as Report 
Headers 

 Report Options 
• Prepared by and Date Prepared options  
• Tax Bracket Percent for estimated tax savings calculation in the Owner 

Summary report 
• Column Headers to describe DC Plan sources for DC Plan Costs report 
• Disclaimer Setup – customizable text included on Title Page and Plan 

Summary reports 
 Create Extract File 

• Check this option to create an extract .xlsx file to integrate into your 
own customized proposal reports 

• Each report selected from the Report Sections will appear on its own 
tab 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#2 – One Participant DC Cash Balance Plan Proposal 

 
D. References  

 
• FAQs 

 

 
FAQ 1099: Maximum Deductible - At Risk Liabilities 
FAQ 932: Maximum Deductible - At Risk Loads 

 
 

• DB Reference Manual 
o Dedicated chapter expected Fall 2021 

 
• Online Help 

o <F1> on keyboard to access online help for each employee or plan specifications field 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#3 – ASC-715 Basics in ASC 

 
Topic Roadmap 

A. Overview of ASC-715 

B. ASC Programming for ASC-715 

C. ASC Results Storage for ASC-715 

D. ASC Reporting for ASC-715 

E. Sample Calculations for ASC-715 

F. References 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#3 – ASC-715 Basics in ASC 

 
A. Overview of ASC-715 

 
• FASB Accounting Standards Codification 715 (formerly FAS 87) 

 
o Required reporting for publicly held plan sponsors and private plan sponsors that 

require Generally Accepted Accounting Principles (GAAP) accounting.  
• Auditor/CPA is responsible for determination of reporting requirement 

 
o Key ASC-715 Terms as found in ASC 

 
ASC-715 Term ASC-715 Description ASC Calculation Description* 

Measurement 
Period 

Fiscal Year • Plan Year Begin/End dates are 
used for calculations 

• Corporation Year End is used to 
report fiscal year end if different 
from Plan Year End date 

Cost Method  Projected Unit Credit • Default cost method for ASC-715 
calculations 

Asset Method Fair Market Value • Assets entered in Market Value 
of Assets field 

Discount Rate Rate at which obligations 
could be settled 

• Single rate pre- and post-
retirement 

• Yield Curve 
Accumulated 
Benefit Obligation 
(ABO) 

Present value of accrued 
benefits 

• Present value as of the valuation 
date of the Accrued Benefit 

Projected Benefit 
Obligation (PBO) 

Present value of accrued 
benefits reflecting salary 
increases 

• Present value as of the valuation 
date of the greater of  

• a) Accrued portion of the FASB 
screen Projected Benefit 

• b) Accrued Benefit 
Service Cost (SC) Present value of benefit 

earned during the year 
• Present value as of the valuation 

date of the greater of a) and b) 
minus the PBO 

• a) Accrued portion as of the end 
of the year of the FASB screen 
Projected Benefit 

• b) Accrued Benefit as of EOY   
* ASC recommends BOY valuations for ASC-715 calculations 
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Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#3 – ASC-715 Basics in ASC 

 
A. Overview of ASC-715 (Continued) 

 
• FASB Accounting Standards Codification 715 (formerly FAS 87) (Continued) 

 
 Assumptions 

• Selected by the plan sponsor, reviewed by auditor 
o Actuary may provide guidance on certain demographic 

assumptions and each assumption should represent “best 
estimate” of that assumption as of the measurement date 

• Discount rate 
o Rate at which obligations could be settled  
o ASC can accommodate the single rates of pre-retirement/post-

retirement interest, tiered rates, or yield curves  
o Tools within ASC  

 Effective interest rate calculation for discount rate 
 Bond matching using projected payouts output 

• Salary Growth rate  
• Mortality 

o Assumption should be appropriate for the employee base 
covered under the plan as of measurement date 

o Reflect expected changes (improvements) in mortality 
 Very common to apply 2D mortality projection scales  

o ASC can accommodate mortality assumptions with mortality 
projection 

• Expected Long-Term Return on Plan Assets 
 

 Reporting requirements  
• Net Periodic Pension Cost 

o ASC report available based on user inputs for components 
• Year-end disclosures of balance sheet 
• Settlement/curtailment reporting 

 
• ASC-715 and the Small Plan Market  
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#3 – ASC-715 Basics in ASC 

 
B. ASC Programming for ASC-715 

 
• Assumptions Coding on Plan Specifications: Assumptions \ FASB screen 

 

 
Plan Specifications: Values \ FASB screen 

 
o Options to enter tiered rates, single rate of pre-retirement interest, single rate of post-

retirement, or yield curve 
  

o Enter pre-retirement tables as needed 
 If Pre-Retirement Mortality, Turnover, or Disability tables are entered, select the 

corresponding Method Used on the Funding \ FUNDMETH screen.  
 

o Asset Long Term Rate of Return  
 Prints on the Summary of Actuarial Assumptions and Projected Payouts reports 

 
o Projected Mortality coding 

 1-D or 2-D projection scales 
 Reminder: When using projection scales, base tables must have the base year 

entered on the 3rd description line of the base table  
 

o Benefit Forms 
 Form of payment will be the annuity specified in the Funding \ BENFORM screen 

 
o Projected Rates 

 To apply assumed annual increase in 415 $ Limits and 401(a)(17) Maximum 
Compensation Limit in the calculation of the FASB projected benefit 
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#3 – ASC-715 Basics in ASC 

 
B. ASC Programming for ASC-715 (Continued) 

 
• Table Maintenance  

 

 
Access > Table Maintenance 

 
o General 

 Mortality 
• Tables may be installed from portable copy available in Client Support 

Center or imported from Excel file 
 

o Defined Benefit folder 
 Bond Yield Curves 

• FTSE yield curve 
o 06/30, 09/30, and 12/31 yield curves included with System 

Patches 
• Other yield curves can be imported 

 Generational Mortality 
• Projection scales included with Patch installation 

 
o Functions 

 Calc PV Factors – to check PVFs  
 Commutation Functions for 2-D Projection scale checking 
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#3 – ASC-715 Basics in ASC 

 
B. ASC Programming for ASC-715 (Continued) 

 
• ASC-715 Programming Tips and Pointers 

 
o Consider making a copy of your PPA Funding case when applying unique coding that is 

specific to the ASC-715 calculations you are trying to achieve 
 

o Recommend using BOY valuation date  
 In Funding \ FUNDMETH screen, set Use BOY Valuation to Yes 

• Refer to FAQ 936: Valuation Dates - Changing from EOY to BOY  
• Refer to System Training > Web Seminars > Defined Benefit 

o DB Top Tips – 2020 - Topic #1 – Changing Valuation Dates 
 

o We’re here to help! 
 The tips and pointers provided may not work for all cases and other approaches 

may achieve the same results. 
 Contact ASC Support with a portable copy of your plan and your objectives 
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#3 – ASC-715 Basics in ASC 

 
B. ASC Programming for ASC-715 (Continued) 

 
• ASC-715 Programming Tips and Pointers (Continued) 

 
o Options for reflecting lump sums in ABO, PBO, and Service Cost calculations  

 Using representative tiered segment rates and lump sum mortality tables 
• Set Rates are PPA Tiered = Yes  
• Enter representative tiered rates to approximate lump sum payments 
• Enter lump sum mortality tables in Post-Retirement Mortality tables  

 Using representative single post-retirement interest rate and lump sum 
mortality tables  

• Set Rates are PPA Tiered = No  
• Enter representative single rate to approximate lump sum payments in 

Post-Retirement interest field 
• Enter a single rate as the discount rate in the Pre-Retirement interest 

fields 
• Enter lump sum mortality tables in Post-Retirement Mortality tables  

 Using Actuarial Equivalence assumptions 
• Set Rates are PPA Tiered = No  
• Enter Actuarial Equivalence post-retirement rate from the Assumptions 

\ ACTEQUIV screen in Post-Retirement interest field 
• Enter a single rate as the discount rate in the Pre-Retirement interest 

field 
• Enter Actuarial Equivalence post-retirement mortality tables in Post-

Retirement Mortality tables 
 Frozen plan coding in Funding \ PPAFASMP 

• Reminder – Make a copy of your plan since you will override the 
Funding \ PPAFASMP screen assumptions for this pointer 

• Set Funding \ BENFORM screen Fund to Lump Sum Limited by 415 field 
to Yes to use the PPA Funding to lump sum calculations  

• Code ASC-715 assumptions in the Funding \ PPAFASMP screen 
• If using an ASC-715 yield curve in Funding \ PPAFASMP 

o ASC system default for yield curve lookup options will be the 
Funding yield curve, but you can type in the ASC-715 yield curve 
table name in the entry field 

• Funding Target result can be used as the ABO and PBO 
  

ASC - Actuarial Systems Corporation 40



Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#3 – ASC-715 Basics in ASC 

 
B. ASC Programming for ASC-715 (Continued) 

 
• ASC-715 Programming Tips and Pointers (Continued) 

 
o Frozen plans using Yield Curve 

 Option to use Calculate Effective Interest Rate to verify ASC-715 discount rate 
developed outside the system using cash flow bond matching process 

 Enter ASC-715 assumptions in Funding \ PPAFASMP screen 
 Select Calculate Effective Interest Rate in the Calculations > Valuation menu.   

• The EIR result will be stored in Values \ VALPPA screen  
 

o Cash balance plans 
 The Projected Unit Credit method applied to cash balance plans generally 

results in PBO equal to ABO because the accrued portion of projected benefit 
will generally be less than the accrued benefit used for PBO (and SC purposes). 

 In some cases, the PBO will not equal ABO and a workaround is necessary to 
achieve the results of having the PBO equal to the ABO. 

• Create a Grid that includes at least the ABO and PBO  
• Consider selecting only active status codes (ABC) to limit which 

participants are affected by this workaround 
• Use Set Column Data to set employee PBO values equal to ABO values 

 
Employee: View > Grid > Set Column Data 

• Run Calculations > Valuation as a Partial Calculation from Plan Totals 
• Print Reports > Actuarial > FASB 

 
• How to Activate ASC Programming for ASC-715 

o Run Calculations > Valuation  
 Calculations for ASC-715 run coincident with those of funding and PBGC 

calculations – no separate calculation step required 
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#3 – ASC-715 Basics in ASC 

 
C. ASC Results Storage for ASC-715 

 
• Employee Results Storage  

 
o Benefits \ FASB screen 

 

 
Employee: Benefits\ FASB 

 
o ASC-715 results  

 Expected Future Service 
• For inactive status codes, value stored is expected future lifetime 

 
o ABO results by decrement  
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#3 – ASC-715 Basics in ASC 

 
C. ASC Results Storage for ASC-715 (Continued) 

 
• Plan Results Storage  

 
o Selected plan level inputs in Costs \ FASBVAL screen 

 Inputs on this screen will appear on Reports > Actuarial > FASB.. > Information 
for FASB87 report 

  
Plan Specifications: Costs \ FASBVAL 
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#3 – ASC-715 Basics in ASC 

 
C. ASC Results Storage for ASC-715 (Continued) 

 
• Plan Results Storage (Continued) 

 
o Active plan total results stored in Values \ VALFASB  

 
Plan Specifications: Values \ VALFASB 

o Retired and Term Vested plan total results stored in Values \ LIABILTY  

 

 
Plan Specifications: Values \ LIABILTY 
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#3 – ASC-715 Basics in ASC 

 
D. ASC Reporting for ASC-715 

 
• Employee Reporting  

 
o From Basic Data \ NAME screen, select F – FAS in the Print Multi-Decrement Support 

field. 
 

o Run Calculations > Valuation to generate the report 
 Illustrates at each age the development of each liability by decrement (normal 

retirement, early retirement, termination, death, disability) 

 
Sample Multi-Decrement Report  
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#3 – ASC-715 Basics in ASC 

 
D. ASC Reporting for ASC-715 (Continued) 

 
• Plan Reporting  

 
o Reports > Actuarial > FASB 

 

 
Reports > Actuarial > FASB Menu 

 
 Highlights of Selected Report Pages  

• Information for FASB87 
o Original FASB87 disclosure format based on 

 Assets input in Costs \ CONTRIB 
 Plan level inputs in Costs \ FASBVAL 
 Plan totals of employee liabilities  

o Review current reporting and disclosure requirements to ensure 
compliance with accounting standards 

• FAS Projected Payouts 
o Payouts based on Projected Benefits 
o Emerging Liability Option will determine payout type: 

 Lump sum payment – lump sum at Normal Retirement 
using post-retirement assumptions on FASB screen  

 Periodic annuity payment – Accrued benefit 
commencing at Normal Retirement 

• FASB Individual Support Page 
o Active, terminated, in pay status reports showing ABO, PBO, 

and SC 
o Active reports include Average Future Service 
o Retired and Terminated reports include Expected Future Life 
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#3 – ASC-715 Basics in ASC 

 
D. ASC Reporting for ASC-715 (Continued) 

 
• Plan Reporting (Continued) 

 
o Reports > Actuarial > FASB Project Payouts… 

 

 
Reports > Actuarial > FASB Proj Payouts… Menu 

 
 

 Options available include exporting to file, selecting specific individual 
employees or specific status codes for reporting 
 

 Payouts based on Projected Benefits 
 

• Emerging Liability Option will determine payout type: 
o Lump sum payment – lump sum at Normal Retirement using 

post-retirement assumptions on FASB screen 
o Periodic annuity payment – Accrued benefit commencing at 

Normal Retirement 
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#3 – ASC-715 Basics in ASC 

 
E. Sample Calculations  

 
• Plan Data 

o BOY Valuation Date: 1/1/2021 
o Unit Benefit Formula: 5% x High 3 Average Compensation for Service up to 20 years 
o ASC-715 Assumptions 

 4% pre- and post-retirement discount rate 
 No pre-retirement decrements 
 PR12WCAM/PR12WCAF post-retirement mortality with MP2020 M/MP2020 F 

2-D generational mortality projection scales 
 

• Participant Data 
o Active Employee1 

 AA – 61 
 RA – 65  
 Sex – Male  
 Service 

• Accrued – 19 
• Service at EOY – 20  
• Total – 23  

 Average Compensation 
• Accrual Average at BOY – 4,007.96 
• Benefit Average at EOY – 4,007.96  
• Projected Average – 4,034.37 

 Benefit  
• Accrued at BOY – 5% x 4,007.96 x 19 = 3,807.56 
• Accrued at EOY – 5% x 4,007.96 x 20 = 4,007.96 
• Projected Benefit – 5% x 4,034.37 x 20 = 4,034.37 
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#3 – ASC-715 Basics in ASC 

 
E. Sample Calculations (Continued) 

 
• Participant Data (Continued) 

 
o Active Employee1 

 
 PVF – 144.73194   

• Stored in EE: Benefits \ FASB screen 
 

• Check Age – Calc APR function 
 

• Basic Check - Calc PV Factors Function 

 
Table Maintenance > Functions > Calc PV Factors Menu 

 

  

ASC - Actuarial Systems Corporation 49



Top Tips for DB Valuation System 
Tuesday, August 10, 2021 

 
#3 – ASC-715 Basics in ASC 

 
E. Sample Calculations (Continued) 

 
• Participant Data (Continued) 

 
o Active Employee1 (Continued) 

 
 PVF – 144.73194 (Continued) 

 
• Advanced Check – Commutation Functions Function 

 
Table Maintenance > Functions > Commutation Functions Menu 

o Projection Factors Report for First Age 65 
 Provides detail of the 2-D Projection Scale adjusted qx 

at First Age 65 

 
Table Maintenance > Functions > Commutation Functions with Projected Factor Input of 65  
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#3 – ASC-715 Basics in ASC 

 
E. Sample Calculations (Continued) 

 
• Participant Data (Continued) 

 
o Active Employee1 (Continued) 

 
 PVF – 144.73194 (Continued) 

 
• Advanced Check – Commutation Functions Function (Continued) 

 
o Commutation Functions Report for range 61 to 65 

 Confirms use of the 2-D Projection Scale adjusted qx 
 12ax column shows the APR at each age 

 
Table Maintenance > Functions > Commutation Functions 

o To check the PVF – APR at 65 discounted at pre-retirement 
interest 
 169.316 x 1.04^ (61-65) = 144.732 
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#3 – ASC-715 Basics in ASC 

 
E. Sample Calculations (Continued) 

 
• Participant Data (Continued) 

 
o Active Employee1 

 ABO 
• Present Value of Accrued Benefit  

• Accrued Benefit x PVF 
• 3,807.56 x 144.73194 = 551,075.55 

 PBO 
• Present value of the maximum of the Accrued Benefit or accrued 

portion of the Projected Benefit 
o Benefit Used for PBO = Maximum [ Accrued Benefit; Accrued 

portion of Projected Benefit ] 
 Maximum [ 3,807.56 ; 19/20 x 4,034.37 ]  
 Maximum [ 3,807.56 ; 3,832.65 ] = 3,832.65 

o PBO = Benefit Used for PBO x PVF  
 3,832.65 x 144.73194 = 554,707.09 

 Service Cost 
• Present value of the maximum of the Accrued Benefit at EOY or accrued 

portion at EOY of projected benefit reduced by the benefit used for PBO 
o Benefit Accrual for Service Cost = Maximum [ Accrued Benefit at 

EOY ; Accrued portion at EOY of Projected Benefit ] - Benefit 
Used for PBO  
 Maximum [ 4,007.96 ; 20/20 x 4,034.37 ] – 3,832.65 
 Maximum [ 4,007.96 ; 4,034.37 ] – 3,832.65 = 201.72 

o SC = Benefit Accrual for Service Cost x PVF 
 201.72 x 144.73194 = 29,195.33 

 
Employee: Benefits \ FASB 
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#3 – ASC-715 Basics in ASC 

 
F. References  

 
• Client Support Center 

o Downloads > System Tables  
 DB Tables - Generational Mortality Projection Documentation.pdf 
 PPA Mortality Tables Import Instructions.pdf 

• This document includes a comprehensive list of available mortality 
tables to download from the System Tables folder 

 
o System Training > Web Seminars > Defined Benefit 

 DB Top Tips – 2020 
• Topic #1 – Changing Valuation Dates 

o FAQs 

 
FAQ 936: Valuation Dates - Changing from EOY to BOY 

 
• DB Reference Manual 

o Chapter 15: FASB Reports 
 

• System Reference Manual 
o Chapter 6: Table Maintenance 

 
• Online Help 

o <F1> on keyboard to access online help for each employee or plan specifications field 
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#1 – American Rescue Plan Act of 2021 

#2 – One Participant DC Cash Balance Plan Proposal 

#3 – ASC-715 Basics in ASC 

#4 – Participant Termination/Optional Forms 

#5 – DB Pattern Plans Overview 

#6 – Extended History 

#7 – Average Compensation Overview 

#8 – Traditional Benefit Formula Coding  

#9 – Participant Reconciliation with Grids and Formulas 
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Topic Roadmap 

A. Accessing the Program 

B. Participant Termination / Optional Forms Menu 

C. Export Factors 

D. Sample Reports 

E. References 

F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan Term/Optional Forms 

Enhancements for Cash Balance Plans 
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#4 – Participant Termination/Optional Forms 

 
A. Accessing the Program 

 
• The Participant Termination / Optional Forms program is designed to provide: 

 
o Lump sum and optional form calculations for individual participants 

 
o Lump sum amounts for all participants in an active or terminated plan 

 
o Option to calculate actuarially increased benefits for late retirees 

 
o PBGC notices of plan benefits for active, terminated, and retired participants in PBGC 

covered terminated plans 
 

• To access these reports, go to ASC Main Menu > Reports > Actuarial > Participant 
Termination/Optional Forms… 

 
ASC Main Menu: Reports > Actuarial > Participant Termination Optional Forms 
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B. Participant Termination / Optional Forms Menu 

 

 
 Reports > Actuarial > Participant Termination Optional Forms 

 
• Employee Selection 

 
• Report Options 
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B. Participant Termination / Optional Forms Menu (Continued) 

 
• Cash Balance Options 

 
o Use CB conv factors for Imm and Ret benefit payment 

 
 Select this option to have the normal form of payment calculated based on Cash 

Balance assumptions entered in the Assumptions \ CASHBAL screen 
 All other optional forms will be calculated based on Actuarial Equivalence 

assumptions entered in the Assumptions \ ACTEQUIV screen 
 

o Use CB conv factors for all opt forms of payment 
 

 Select this option to have all optional forms of payment calculated based on 
Cash Balance assumptions rather than Actuarial Equivalence assumptions 
 

o Show cash balance basis 
 

 Select this option to include the total cash balance contribution credits from the 
participant’s Employee \ Costs \ CASHBAL \ Basis in Account field on the 
Calculation Worksheet 
 

o Show cash balance contribution history 
 

 Select this option to include the cash balance contribution history on the 
Calculation Worksheet 
 

o Additional information 
 

 2020 Top Tips for the DB Valuation System #8 – Plan Term Optional Forms 
Enhancements for CB Plans provides sample reports and calculations specific to 
Cash Balance plans. The handout from that session is included with this topic in 
Appendix A 

 The DB Reference Manual, Chapter 5: Participation Termination/Optional 
Forms, Example 2 has additional sample reports with calculations that cover a 
variety of combination of selections from the Participant Termination / Optional 
Forms menu 
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#4 – Participant Termination/Optional Forms 

 
B. Participant Termination / Optional Forms Menu (Continued) 

 
• Calculation Options  

 
o Enter a Calculation Date after the plan year begin date and not more than 12 months 

after the plan year 
 

o Present Values can be recalculated using nearest year, month or day or the value stored 
in participant screens can be used if “Do Not Recalculate” is selected. The APRs used for 
this calculation will be weighted based on the selected option.  
 The following employee fields are used when “Do Not Recalculate” is selected: 

Benefits \ ACCRBENF \ Present Value of Accrued Benefit for 417e and Costs \ 
LIABILITY \ 415 Immediate Lump Sum Benefit. The report can be overridden by 
manually editing these fields to any value you determine is appropriate before 
printing. 

 Update Assumptions \ 417E and MAXBNADJ screens with the parameters 
applicable to the calculation period.  

 415 calculations are based on Completed Months  
 

o Calculate Annuity Payments to the Nearest Year or Nearest Month 
 

• Optional Forms to Show 
 

o Forms and the factors used are included in the Export Factors File  
 

• PBGC Benefit Commitments 
 

o Actives – used for Active and Terminated Participants 
 

o Retired – for participants in pay status 
 

o Enter the Plan Termination Date, Extended Termination Date, if applicable, Proposed 
Distribution Date and Involuntary Cashout amount, if applicable in the Participation 
Termination / Optional Forms Menu. These entries will be included in the reports 
 If no Involuntary Cashout amount is entered, the report will assume participant 

and spousal consent, if married, are required for benefit payments 
 

• Export Factors 
 

o Option to export factors becomes available when Optional Forms report selected 
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#4 – Participant Termination/Optional Forms 

 
C. Export Factors 

 
• Create export factors file  

 
o Fixed columns allow user to integrate the data with other documents 

 
o Can be used to integrate with Relative Value Disclosure Forms  

 
o Can be used to check the Participant termination / Optional Forms Report results 

 
• Data extracted includes: 

 
o Factors, such as: employee data, retirement age, optional form calculations for Optional 

Forms selected in the menu 
 

o Params – Information shown in the Parameters report 

 
Sample Participation Termination Optional Forms \ Export Factors file 
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D. Sample Reports 

 
• Report output will change for traditional or cash balance plans 

 
• Refer to the DB Reference Manual – Chapter 5: Participant Termination Optional Forms for 

sample cash balance reports and sample calculations  
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D. Sample Reports (Continued) 

 
• Single Lump Sum Worksheet: Traditional DB Plan 

 
o Details on the top of this page include key ages used in the calculation of the 417(e)(3) 

Lump Sum and 415 maximum calculations below 
 

o For a Cash Balance Plan, this report includes interest crediting rate, interest to 
Calculation Date and Cash balance account as of Calculation Date 

 

 
Participant Termination Optional Forms: Single Lump Sum Worksheet 
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#4 – Participant Termination/Optional Forms 

 
D. Sample Reports (Continued) 

 
• Calculation Worksheet: Traditional DB Plan 

 
o Summarizes participant data used in calculations 

 
o For a cash balance plan, this report includes Account Value, conversion factors, and 

optional Cash Balance Basis and Contribution History (options available in the 
Participant Termination/Optional Forms menu) 

 

 
Participant Termination Optional Forms: Calculation Worksheet 
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#4 – Participant Termination/Optional Forms 

 
D. Sample Reports (Continued) 

 
• Participant Statement with Optional Forms: Traditional DB Plan 

 
o Joint and Survivor calculation assumes Spouse is the same age as the Participant If 

Spouse’s Birth is not entered in the Employee \ Basic Data \ DATE screen 
 

o Optional forms are calculated as of the date entered in Calculation Date field and at 
Normal Retirement Date.  
 

o For cash balance plans, the Participant Termination / Optional Forms menu includes 
options to use CB conversion factors to calculate the optional forms reported here 

 

 
Participant Termination Optional Forms: Participant Statement with Optional Forms 
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#4 – Participant Termination/Optional Forms 

 
D. Sample Reports (Continued) 

 
 PBGC Notice of Plan Benefits: Traditional DB Plan, Active participants 

 
o Includes Termination Date, Extended Term Date, if applicable, Distribution Date and 

Involuntary Cashout, if applicable, entered from the program menu 
 

o For Cash Balance Plans, this report includes applicable cash balance interest rates and 
states that “For Cash Balance Plans, the single lump sum value is the cash balance 
account value” 

 

 
Participant Termination Optional Forms: Notice of Plan Benefits, Page 1 
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D. Sample Reports (Continued) 

 
• PBGC Notice of Plan Benefits: Traditional DB Plan, Active participants (Continued) 

 

 
Participant Termination Optional Forms: Notice of Plan Benefits, Page 2 
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#4 – Participant Termination/Optional Forms 

 
E. References 

 
• FAQs 

 

 

FAQ 745: Optional Forms – Calculating lump sums & joint and survivor annuities 
FAQ 1023: 415 Maximum Lump Sum 
 

• DB Reference Manual 
o Chapter 5: Participant Termination/Optional Forms 
 

• Reports Reference Manual 
o DB Reports 

 
• 2020 DB Top Tips  

#8 – Plan Term Optional Forms Enhancements for CB Plans 

  

ASC - Actuarial Systems Corporation 67

http://csc.asc-net.com/ProjectsBasket/CSC/faqNew/articles/Defined%20Benefit/FAQ745_Optional_Forms_-_Calculating_lump_sums__joint_and_survivor_annuities.htm
http://csc.asc-net.com/ProjectsBasket/CSC/faqNew/articles/Defined%20Benefit/FAQ1023_415_Maximum_Lump_Sum.htm


Top Tips for the DB Valuation System 
Tuesday, August 10, 2021 

 
#4 – Participant Termination/Optional Forms 

 
F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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F. Appendix A: 2020 Top Tips for the DB Valuation System #8 – Plan 

Term/Optional Forms Enhancements for Cash Balance Plans (Continued) 
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 Topic Roadmap 

A. ASC Pattern Plans 

B. Creating New Pattern Plans 

C. Setting up Pattern Plans for Commonly Used Designs 

D. Updating Pattern Plans 

E. References 
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#5 – DB Pattern Plans Overview 

 
A. ASC Pattern Plans 

 
• Pattern plans are templates on which new plans are based. They contain Plan Specifications with 

default settings, but no employee data and are stored in the DEF Pattern Plans library 
 

• The ASC System contains pre-created pattern plans  
o DB Pattern Plan 
o DC Pattern Plan 
 

• Custom Pattern Plans can be created 

 
B. Creating New Pattern Plans 

 
• Creating custom pattern plans with your commonly used designs saves you time when creating 

new plans in the future.   
 

• Coordinate with a designated individual on your team to create pattern plans and keep them 
updated each year.  
 

• To create a pattern plan: 
1. File > New Plan 
2. Highlight the DEF Library and DB Pattern Plan 
3. Click OK – and Yes to confirm that you want a new Pattern Plan 
4. A Pattern Plan can be copied into a Pattern Plan 

 
ASC Main Menu: File > New Plan 
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#5 – DB Pattern Plans Overview 

 
C. Setting up Pattern Plans for Commonly Used Designs 

 
• Set up Pattern Plans for 

 
o BOY and EOY Valuation Dates 
o Traditional Designs and Cash Balance Plans 
o Template for our new DC/CB Proposal program for one participant plans  

 
• Common Recommended Settings 

 
o Plan Specifications 
 

 General \ Identification \ ID 
• If setting up a Pattern Plan for Cash Balance Plans, set Cash Balance Plan 

to Yes   

 
Plan Specifications: General \ Identification \ ID screen 

  

ASC - Actuarial Systems Corporation 94



Top Tips for the DB Valuation System 
Tuesday, August 10, 2021 

 
#5 – DB Pattern Plans Overview 

 
C. Setting up Pattern Plans for Commonly Used Designs (Continued) 

 
• Common Recommended Settings (Continued) 

 
o Plan Specifications (Continued) 

 
 General \ Identification \ ANCILELG \ Early Retirement  

• Set provisions to match Normal Retirement Provisions of the RETIRE 
screen 

• Set Vest at Early Retirement to Yes 
 

 
Plan Specifications: General \ Identification \ ANCILELG 
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#5 – DB Pattern Plans Overview 

 
C. Setting up Pattern Plans for Commonly Used Designs (Continued) 

 
• Common Recommended Settings (Continued) 

 
o Plan Specifications (Continued) 

 
 General \ Identification \ ACCRUAL  

• Set Accrual before Apply Maximum to Yes. This field should always be 
set to Yes when Type of Accrual is set to 5 – Unit Per Formula 

• Starting Date field in the ACCRUAL and Benefit Formula screens 
• 2 – Plan Year – accrual service begins on the participant’s 

Accrual Start date 
• 4 – BOY Entry – accrual service begins in the plan year 

containing the participant’s Entry date 
• Set Starting Date, Basis of Year, and Days in First Year/Retirement Year 

to match the coding in the Benefit Formula screen  

 
Plan Specifications: General \ Identification \ ACCRUAL 
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#5 – DB Pattern Plans Overview 

 
C. Setting up Pattern Plans for Commonly Used Designs (Continued) 

 
• Common Recommended Settings (Continued) 

 
o Plan Specifications (Continued) 

 
 General \ Compensation \ COMPAVG  

• Set Maximum Applies to 4 – Year 2001 Law for all post-EGTRRA plan 
years. 

 

 
Plan Specifications: General \ Compensation \ COMPAVG 
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#5 – DB Pattern Plans Overview 

 
C. Setting up Pattern Plans for Commonly Used Designs (Continued) 

 
• Common Recommended Settings (Continued) 

 
o Plan Specifications (Continued) 

 
 General \ Compensation \ LEGALAVG 

• Set Limit by 401(a)(17) to Yes 
 

 
Plan Specifications: General \ Compensation \ COMPAVG 

 
 General \ Compensation \ MAXBEN 

 
 Funding \ FUNDASMP  

• Needs to be coded with interest rates and valid mortality tables to avoid 
errors that will terminate the Calculations > Valuation routine.  

 
 Funding \ FUNDMETH 

• Beginning of Year Valuation 
• Use BOY accrued benefit for funding target  

 
 Assumptions \ CASHBAL 

• Disregard Prior Accrued Benefit  
 

 Values \ VALPPA 
• Prior Funded percent for 430(f)(3) = 80%  
• Last Year AFTAP = 100% 
• ARP Relief 1st Val Date 
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#5 – DB Pattern Plans Overview 

 
C. Setting up Pattern Plans for Commonly Used Designs (Continued) 

 
• Common Recommended Settings (Continued) 

 
o Reports > Valuation > PPA DB…. – Preselect your typical Report Sections and Options, 

such as: 
 

 Include Late Quarterly Interest 
 Qualification Standards 

 
o Compliance Testing menus 

 
 Mortality Table 
 Interest Rates 
 Rate Calculation Methods 

 
o Extended History Records 
 

  Utilities > Change Structure > Extended History Records 
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#5 – DB Pattern Plans Overview 

 
D. Updating Pattern Plans 

 
• Pattern plans are not automatically updated with system updates to avoid resetting any custom 

specification coding you choose to use  
 

• Update to New Period: Delete history records and note prior year values that were updated 
during this process 
 

• Manual Update: The following fields should be reviewed each year and updated if necessary 
(additional fields should be reviewed depending on the specifics of your pattern plan): 

 
o General \ Identification \ ID \ Plan Year Begin, End, Insurance Issue Date, Effective Date 
o General \ Compensation \ COMPAVG \ Maximum Compensation 
o General \ Compensation \ MAXBEN \ Maximum Benefit 62 to 65 
o Funding \ PPAFASMP \ Interest Rates and Mortality 
o Assumptions \ ACTEQUIV \ Mortality  
o Assumptions \ MAXBNADJ \ Post-Retirement Mortality 
o Assumptions \ 417E \ Interest Rates and Mortality 
o Assumptions \ PBGCPREM \ Interest Rates, Mortality, Premium Information 
o Assumptions \ CASHBAL \ Interest Rates and Mortality 
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#5 – DB Pattern Plans Overview 

 
E. References 

 
• FAQs 

 

 
 

FAQ 763: Pattern Plan Update 
 

• Systems Reference Manual 
o Chapter 1: Plan Management 

 
• DB Reference Manual  

o Chapter 3: Cash Balance Plans 
 Creating a Cash Balance Pattern Plan 

 
• Online Help 

o <F1> on keyboard to access online help for each employee or plan specifications field 
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#6 – Extended History 

 
Topic Roadmap 

A. Overview 

B. Employee Extended History 

C. Plan Specifications History 

D. History Utilities  

E. Exporting Employee History using ASCript and Grids 

F. References 
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#6 – Extended History 

 
A. Overview 

 
• Plan and Employee history records store useful information that can be exported from the plan 

or used to analyze historical data 
 

• Plan and Employee history fields are automatically stored each year when Update to New Period 
calculations are run and a new history record for the prior year is created 
 

• A history record can be manually added, and history fields can be manually input as well  
 

• Use history records to: 
 

o Export historical employee data using ASCript or Grids 
 Exports can be used to populate custom reports 

 
o Monitor changes in dates (i.e., retirement, hire, term) 

 
o Study trends in employee data  

 

  

ASC - Actuarial Systems Corporation 104



Top Tips for the DB Valuation System 
Tuesday, August 10, 2021 

 
#6 – Extended History 

 
B. Employee Extended History 

 
• Basic Data \ HISTORY 

 

 
Employee: Basic Data \ HISTORY 

 
• The extended history records contain historical employee fields that are stored during the 

Update to New Period routine 

 
• The Employee history record for the previous plan year is created and populated when a plan is 

updated to a new period. A history record and history fields can also be manually entered by the 
user or populated with ASCript Import.  The most recent employee history record is the last day 
of the prior compensation year, for example: 
 
For a 2021 Calendar Year plan, the most recent employee history record is: 

o BOY Valuation Date Plan – 12/31/2019 
o EOY Valuation Date Plan – 12/31/2020  

 
• View Extended history by selecting a history record and click “Modify.” In the History record, 

click one of the “Ext” buttons on the top of the screen.  
 

• All fields in Extended History can be overridden 
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#6 – Extended History 

 
B. Employee Extended History (Continued) 

 
• Extended History A 

 

 
Employee: Basic Data \ HISTORY \ Extended History A 

 
o Contains fields from the NAME, DATE, CASHBAL screens as well as excluded 

compensation and the Cash Balance APR 
 Cash Bal APR – relevant for postponed retirees and BOY tested plans with 

variable interest rates 
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#6 – Extended History 

 
B. Employee Extended History (Continued) 

 
• Extended History B 

 

 
Employee: Basic Data \ HISTORY \ Extended History B 

 
o Contains fields from the 415 immediate lump sum limit calculations, BOY and EOY 

accrued benefits, Present values for Plan Assumptions, Top-Heavy and 417(e) purposes, 
Current Service, Total Service, Vesting Service, and offset and add-on fields 
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#6 – Extended History 

 
B. Employee Extended History (Continued) 

 
• Extended History C 

 
Employee: Basic Data \ HISTORY \ Extended History C 

 
o Contains average compensation at the valuation date and at the end of the year for Plan 

Benefits, Top-Heavy, and 415 maximum purposes  
 

• Extended History D 

 
Employee: Basic Data \ HISTORY \ Extended History D 

 
o Contains the distribution date and gross amount paid fields input in the Benefits \ 

SOLEPROP screen 

 

  ASC - Actuarial Systems Corporation 108



Top Tips for the DB Valuation System 
Tuesday, August 10, 2021 

 
#6 – Extended History 

 
C. Plan Specifications History 

 
• Located in Values \ HISTORY 

 

 
Plan Specifications: Values \ HISTORY 
 

o Assets, Balances, EIR and PPA Minimum and Maximum Funding values 
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#6 – Extended History 

 
D. History Utilities 

 
• Creating Extended History Records 

 
o Utilities > Change Structure > Extended History Records… 
 

 
ASC Main Menu: Utilities > Change Structure > Extended History Records… 

 
o Automatically enabled when the Calculations > Update to New Period program is run 

 
o Manually enabled by selecting Utilities > Change Structure > Extended History Records 

from the ASC Main Menu 
 

 This selection also enables History records in Plan Specifications. Plan 
Specifications \ Values \ HISTORY records are created during the Update to New 
Period routine.  
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#6 – Extended History 

 
D. History Utilities (Continued) 

 
• Part-Time EE History Hours… 

 
o Utilities > Change Structure > Part-Time EE History Hours… 

 

 
ASC Main Menu: Utilities > Change Structure > Part-time EE History Hours 

 
o This command creates history records and stores a value of 1 in the Hours field for 

employees coded as Participation Status code J in the DATE screen 
 

o Includes option to replace existing 0 (blank) hour history records with 1 hour   
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#6 – Extended History 

 
D. History Utilities (Continued) 

 
• Combine EEs… 

 
o Utilities > Change Structure > Combine EEs.. 

 
ASC Main Menu: Utilities > Change Structure > Combine EE… 

 
o This command will combine or move basic data from one employee record to the other 

employee record 
 
 Dates of Birth, Hire, Termination and Rehire, and History records are moved if 

they do not already exist in the destination record 
 

 If the combined hours are less than 3,001, then both Compensation and Hours 
are combined in the destination record 
 

 If the combined hours exceed 3,000, then only Compensation is combined in the 
destination record 

 
o The “FROM” employee record data is deleted when the program is complete  
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#6 – Extended History 

 
E. Exporting Employee Data using ASCript and Grids 

 
• ASCript Export 

 
o Select “New, exporting Employee detail data such as history or transactions” to export 

records for all historical entries or for selected dates for every participant  
 

 

 

 

 

 

 
 
 
 
 
 
 
 

ASCript: Wizards \ Export 
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E. Exporting Employee Data using ASCript and Grids (Continued) 

 
• ASCript Export (Continued) 

 
o Click Edit to Select items to export  
 

 
ASCript: \ Wizards \ Export \ Select items to export 

 

 
ASCript: \ Wizards \ Export \ Select items to export – Find Item 
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#6 – Extended History 

 
E. Exporting Employee Data using ASCript and Grids (Continued) 

 
• ASCript Export (Continued) 

 
o ASCript Export can be saved as an .xls file  
 

 
Sample ASCript Export .xls 
 

o Variable export file can be saved for future exports 
 

 

  

ASC - Actuarial Systems Corporation 115



Top Tips for the DB Valuation System 
Tuesday, August 10, 2021 

 
#6 – Extended History 

 
E. Exporting Employee Data using ASCript and Grids (Continued) 

 
• Employee Grids 

 
o Employee Grids can be used to view data in the ASC system. The data can then be 

copied to a clipboard and pasted into a spreadsheet 
 

 Select the HISTORY Form Name and Item name and enter the History Date(s) 
you would like to add to the Grid 

 

 
Employee: View > Grid > New 
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#6 – Extended History 

 
E. Exporting Employee Data using ASCript and Grids (Continued) 

 
• Employee Grids (Continued) 

 
o Click ‘OK’ to view Data in Grid 

 

 
Employee: View > Grid > Sample Grid output 

 
o Copy to Clipboard to paste into a spreadsheet 

 

 
Employee: View > Grid > Copy to Clipboard 
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F. References 

 
• DB Reference Manual  

o Chapter 1: Plan Specifications 
o Chapter 2: Employee Data 

 
• Grid Manual  

o Chapter 1: Grid Basics  
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#7 – Average Compensation Overview 

 
Topic Roadmap 

A. Overview of Average Compensation in ASC 
 

B. Average Compensation Options 
 

C. Average Compensation Storage in Employee Screens 
 

D. Basic Average Compensation Examples 
 

E. Advanced Average Compensation Considerations 
 

F. References 
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#7 – Average Compensation Overview 

 
A. Overview of Average Compensation in ASC 

 
• In general, average compensation results are used to determine or limit benefits.   

 
• For formulas based on average compensation, reviewing the active participants’ various average 

compensation fields and compensation averaging options are steppingstones for how ASC 
calculates or limits their benefits.   
 

• During Calculations > Valuation, ASC can calculate many compensation averages for 
participants.  Examples of calculated average compensations are: 

 
o 415 compensation limits 

 
o Top heavy minimum benefits 

 
o Projected Benefits 
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B. Average Compensation Options 

 
• Plan Specifications \ General \ Identification \ Compensation 

 
Plan Specification: Compensation \ COMPAVG screen 

o The COMPAVG and LEGALAVG screens contain most of the average compensation 
options.  Other screens have their related options. 
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B. Average Compensation Options (Continued) 

 
• General \ Identification \ Compensation \ COMPAVG (Compensation Averaging) screen 

 
Plan Specification: Compensation \ COMPAVG screen 

o Plan Average section for plan benefit calculations: 
 Averaging Period: defines the number of years averaged for their highest 

averaging period. 
 Exclude Comp during Last: the number of final years to be disregarded in 

determining plan benefit average compensation. 
 Average during Last: defines the years considered for the average 

compensation. 
 First, Retirement, and Termination Years: Special options for these years. 

• Note, if First Year is set to 4 – Omit Pre-Entry, Consecutive Month Avg 
should be set to Yes 

 Consecutive Month Avg: determines if average annual or average monthly 
compensation is determined.   

 Use Consecutive Years: determines if their highest paid years needs to be 
consecutive for their average   

 
o Compensation Limits for maximum compensation considered 

 Maximum Compensation: for the plan year compensation limit and reporting in 
reports.   

• Note, the system applies the applicable 401(a)(17) compensation limit 
to their HISTORY record for each year. 

 Other options are available on this screen.  After selecting a field with your 
mouse, press <F1> on your keyboard to view Online Help for the details. 
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B. Average Compensation Options (Continued) 

 
• General \ Compensation \ LEGALAVG (Legal Limit Compensation Averaging) screen 

 
Plan Specification: Compensation \ COMPAVG screen 

o Top Heavy Minimum Average section for Top Heavy Benefit purposes 
 

o Maximum Benefit Average section for 415 % of Compensation purposes 
 Limit by 401(a)(17) Compensation should be set to Yes for years beginning 

after 6/30/2007 

o The settings on this screen operate similarly to the options on the COMPAVG 
screen.   
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B. Average Compensation Options (Continued) 
 

• Funding \ PPAFASMP (PPA Funding Assumptions) screen 
 

 
Plan Specification: Funding \ PPAFASMP screen 

 
o Salary Scale 

 Only the 1st two salary scales will be used when using group formulas 
 

o Salary Scale for Principals 
 Set participants’ Basic Data \ NAME \ Principal field to Y-Yes to have Salary 

Scales for Principals apply to these participants 
 Will not apply when using group formulas 

 
o Salary Scales do not impact the calculation of % of pay group formula CB credits 
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B. Average Compensation Options (Continued) 

 
• Assumptions \ FASB (FASB Assumptions) screen 

 
Plan Specification: Assumptions \ FASB screen 

o Salary Scales 
 These salary scale will apply to all participants with no distinction between 

participants coded as Principals or non-Principals as used by the PPAFASMP 
screen. 

 
o Increase Maximum Comp 

 Input to assume increases in Maximum Compensation limits. 
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B. Average Compensation Options (Continued) 

 
• After changing a compensation selection, run Calculations > Valuation to update the results.  In 

general, Complete Calculations is recommended.   
 

o However, if Partial Calculation is run starting at Social Security, Average Salaries, 
Calculate Benefits or Calculate Present Values, all four of these calculations will run 
and average compensation fields for participants are recalculated. 

 
Calculations > Valuation menu 
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C. Average Compensation Storage in Employee Screens 
 

• Employee \ Basic Data \ COMP (Compensation) screen 

 
Employee: Basic Data \ COMP screen 

o Plan Benefit, 415 Maximum Benefit, and Top Heavy Minimum average monthly 
compensation sections show average monthly compensations similarly.   

 
 Projected Average: the estimated average compensation at retirement with 

a 0.00% salary scale.   
• Used with death benefits 

 Funding Average: the estimated average compensation at retirement with 
the PPAFASMP input salary scales applied 

• Used projected benefits for funding or deduction cushions 
• May apply for pre-PPA funding methods 

 Accrual Average: the average compensation as of the valuation date 
• Used for calculating accrued benefit for pay-related plans  

 Prior Accrual Average: the average compensation as of the prior valuation 
date 

• For EOY valuations, these inputs can impact the Begin of Year 
Accrued Benefit   

• This value is not calculated during Calculations > Valuation.   
• It is stored during Update to New Period and can be manually 

entered. 
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#7 – Average Compensation Overview 

 
C. Average Compensation Storage in Employee Screens (Continued) 

 
• Employee \ Benefits \ FASB (FASB/Integration) screen 

 
Employee Window: Benefits \ FASB screen 

o Projected Average compensations is the estimated average compensation at retirement 
using the salary scale input and increase maximum assumptions entered on the 
Assumptions \ FASB screen. 
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#7 – Average Compensation Overview 

 
C. Average Compensation Storage in Employee Screens (Continued) 

 
• Employee \ Costs \ LIABILTY (Liability) screen 

 
Employee Window: Costs \ LIABILTY screen 

o Benefit Average, Minimum Average, Maximum Average are the end of year plan 
accrued benefit, top-heavy and 415 maximum compensation averages 

 These are used for the calculation of end of year accrued benefits 
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D. Basic Average Compensation Examples 

Example Participant Data Related Plan Specifications 
• Hire Date: 06/21/2019 

o  18 completed months of employment 
• Entry Date: 7/1/2020 

o 6 months of participation 
• 12/31/2019 Compensation in HISTORY: 33,540.00 
• Current Compensation on COMP screen: 67,817.88 
 

• 1/1/2021 BOY Valuation  
 
 

• Settings on the General \ Compensation \ COMPAVG screen will be adjusted to illustrate the impact on the participant’s Basic Data \ COMP \ 
Plan Benefit Accrual Average compensation. 

 
Employee: Basic Data \ COMP screen 
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#7 – Average Compensation Overview 

 
D. Basic Average Compensation Examples (Continued) 

Example 1 – Yearly  Example 2 – Monthly  Example 3 – Omit Pre-Entry  Example 4 – Annualize 

    
Compensation Considered 

2019: 33,540.00:  
2020: 67,817.88 

Divisor 
Yearly = 2 x 12 = 24 
 

Accrual Average 
(33,540.00 + 67,817.88) / 24  = 

4,223.25 

Compensation Considered 
2019: 33,540.00: 
2020: 67,817.88 

Divisor 
Completed Months = 18 
 

Accrual Average 
(33,540.00 + 67,817.88) / 18  =  

5,630.99 

Compensation Considered 
2019: 0.00 
2020: 67,817.88 

Divisor 
Completed Months = 6 

 
Accrual Average 

67,817.88 /   6   = 11,302.98 

Compensation Considered 
2019: Compensation / Days in First 
Yr x 372 = 63,334.42 
2020: 67,817.88 

Divisor 
Completed Months = 18 

Accrual Average 
(63,334.42 + 67,817.88) / 18 =  

7,286.24 

    

ASC - Actuarial Systems Corporation 132



Top Tips for the DB Valuation System 
Tuesday, August 10, 2021 

 
#7 – Average Compensation Overview 

 
E. Advanced Average Compensation Considerations 

 
• Employee HISTORY records 

 
o If the compensation field in an employee’s record is left blank, years surrounding the 

blank year will be treated as consecutive for calculating average compensation 
 

• Employee: Basic Data \ COMP \ Extra Compensation and HISTORY \ Ext A \ Excluded 
Compensation 

 
o Can be used to store compensation for maximum or minimum benefit purposes but not 

be included for plan benefit average compensation.   
 

• Employee Multi-Decrement Support Report 
 

o Generated during Calculations > Valuation if their Basic Data \ NAME \ Print Multi-
Decrement Support is set to one of the Y options 
 

o Report provides helpful details on historical and projected compensation averages 
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#7 – Average Compensation Overview 

 
E. Advanced Average Compensation Considerations (Continued) 

 
• Plan Specification \ General \ Compensation \ COMPAVG \ Compensation is Input field 

o Set to No, turn off the 415 % of Compensation limit.   
 Often used for frozen plans that do no load compensation history. 

 

 
Plan Specification: Compensation \ COMPAVG screen 

 
• Cash Balance Plans 

 
o Generally, cash balance plans do not use average compensation with the benefit 

formulas 
  Instead, employee’s Current Compensation and Current Annual Compensation 

Rate are used.   
 Cash Balance Contribution credits calculated using Unitized Minimum 

programming do use their plan benefit average compensation 
 

o Set Plan Specifications \ COMPAVG: Averaging Period and Average during Last both to 1 
to achieve current annual compensation testing method 
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#7 – Average Compensation Overview 

 
F. References 

 
• FAQs 

 
FAQ 480: Compensation average calculation 
FAQ 911: Cushion Amounts - Calculations for salary increase  

 
• DB Reference Manual 

 
• Online Help 

o <F1> on keyboard to access online help for each employee or plan specifications field 
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Topic Roadmap 

A. Setting Up the ACCRUAL Screen 
 

B. Setting Up Benefit Formula Screens 
 

C. Fractional Benefit, Unit Benefit, and Fresh Start Examples 
 

D. References 
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#8 – Traditional Benefit Formula Coding 

 
A. Setting Up the ACCRUAL Screen 

 
• Plan Specifications \ General \ Identification \ ACCRUAL screen  

Plan Specification: General \ Identification \ ACCRUAL screen 

o Type of Accrual options 
 

 1 - Yr/Yr Project Avg 
• A fractional accrual of years over years, to a projected benefit based on 

a projected average salary. 
 2 - Yr/Yr Curr Avg 

• Fractional Accrual where service is not limited to a number of years and 
based on current average salary 

o Often used with FLATBENF type formulas 
 3 - % per Year 

• Accrual based on a percentage per year. 
 4 – Front End 

• Fractional Accrual where service is limited to a number of years as input 
on the Years for Full Accrual field. 

o Often used with FLATBENF type formulas 
 5 – Unit Per Formula 

• Accrual based on the service entered on the formula screens. 
• Often used with UNITBENF, CARRBENF, and Cash Balance formulas.   
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#8 – Traditional Benefit Formula Coding 

 
A. Setting Up the ACCRUAL Screen (Continued) 

 
• Plan Specifications \ General \ Identification \ ACCRUAL screen (Continued) 

 
Plan Specification: General \ Identification \ ACCRUAL screen 

o Starting Date options 
 
 1 – Hire 

•  Accrual periods are employment anniversary years starting with hire 
date and ending each 12 months thereafter 

 2 – Plan Year 
• Accrual period use the same fiscal year as the plan year 
• Does not limit to service while a participant 

 3 – Entry 
• Accrual period are the years starting with entry date and ending each 12 

months thereafter 
 4 – BOY Entry 

• Accrual period uses the same fiscal year as the plan year but starts with 
the first year of participation 

• Recommended for cash balance plans 
 5 – BOY Eligible 

• Accrual period uses the same fiscal year as the plan year but starts with 
the first year a participant could have been eligible if the plan was in 
existence 

 These options can impact the calculation of the Basic Data \ DATE \ Accrual Start 
date for participants with status code B or C.  Manually changing their Accrual 
Start date is possible with status code A participants but review the results to 
ensure they are as expected. 
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A. Setting Up the ACCRUAL Screen (Continued) 

 
• Plan Specifications \ General \ Identification \ ACCRUAL screen (Continued) 
 

 
Plan Specification: General \ Identification \ ACCRUAL screen 

 
o Basis of Year Options: 

 1 – Exact Year 
• Accrual service is prorated on the number of days out of each year 
• ASC counts each month to have 31 days for a 372-day year 

 2 – 1,000 Hours 
• In general, if hours equal or exceeds 1,000 hours then that year is 

counted for benefit service 
 3 – 500 Hours 

• In general, if hours equal or exceeds 500 hours then that year is counted 
for benefit service 

 4 – X Hours 
• In general, if hours equal or exceeds the hours requirement input in the 

Hours field then that year is counted for benefit service 
 Note, Days in First Year and Retirement year may impact whether a year is 

considered  
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#8 – Traditional Benefit Formula Coding 

 
A. Setting Up the ACCRUAL Screen (Continued) 

 
• Plan Specifications \ General \ Identification \ ACCRUAL screen (Continued) 

 
Plan Specification: General \ Identification \ ACCRUAL screen 

o Days in First Year and Retirement Year 

 In general, these days in first or retirement year have two effects: 
• For the first or retirement year, if that year has less than the number of 

days input, that year is generally excluded 
• If hours are not input for the first or retirement year (often for their 

projected benefits), then the number of days is used to estimate if they 
met the accrual retirements 

 The 163 entered above in Days in First Year is 5 months, 1 week and a day (5 x 
31+7+1 = 163) 

 The 186 entered above in Days in Retirement Year is 6 months (6 x 31 = 186) If 
hours are blank, 2080 hours are assumed for the year.   

• Do not input 1,000 hours if not importing actual hours.  That may cause 
unexpected results for eligibility or projected benefits   
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A. Setting Up the ACCRUAL Screen (continued) 

 
• Plan Specifications \ General \ Identification \ ACCRUAL screen (Continued) 

DB Plan Specification: General \ Identification \ ACCRUAL screen 

o Other ACCRUAL screen settings to consider  
 
 Excl. Years < Effective Date 

• Set this to Yes to exclude service before the effective date 
 Accrual before Apply Maximum 

• For fractional accruals this defines whether the accrual fraction shall be 
applied before or after the application of the maximum benefit. 

• For Unit Accruals, this should be set to Yes 
 Accrual Before Apply Minimum 

• For fractional accruals this defines whether the accrual fraction shall be 
applied before or after the application of the minimum benefit (other 
than top heavy) 

 Years for Full Accrual 
• For Front End and Unit Accrual methods, this input will be used for the 

maximum number of accrual years 
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#8 – Traditional Benefit Formula Coding 

 
A. Setting Up the ACCRUAL Screen (Continued) 

 
• Plan Specifications \ General \ Identification \ ACCRUAL screen (Continued) 

 
o ACCRUAL screen selections should generally match the coded benefit formula screen(s) 

 
 The benefit formula options operate similarly but apply to benefit service 

calculations instead of accrual service calculations 
 Both exclude years options also match between the two sample screens below 
 The Calculations window may provide warning messages if the settings are 

different. 
 
 

 

 

 

 

 

 

Table Maintenance \ 
DB/CB Formulas \ 

Sample Unit Benefit 
Formula 

 

 
Plan Specification: General \ Identification \ ACCRUAL screen 

 

   

ASC - Actuarial Systems Corporation 143



Top Tips for the DB Valuation System 
Tuesday, August 10, 2021 

 
#8 – Traditional Benefit Formula Coding 

 
B. Setting Up Benefit Formula Screens 

 
• Plan Specifications \ General \ Benefits \ FLATBENF screen 
 

 
Plan Specification: General \ Benefits \ FLATBENF screen 

 
o Generally, to be used with Accrual Types of Yr/Yr Curr Avg or Front End  

 
o Pct of Comp and Dollar Amt 

 
 Standard benefit formula options 

 
o Pct of Excess and Excess over:  

 
 Used for integrating with social security  

 
o Reduce for Year Less Than 

 
 Used for prorating the benefit formula for participant that have less than the 

projected number of years as input 
 

o Other Settings 
 

 Review Online Help for additional details on other options 
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#8 – Traditional Benefit Formula Coding 

 
B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ General \ Benefits \ OFFBENF screen 

 
 Plan Specification: General \ Benefits \ OFFBENF screen 

 
o To be used in conjunction with the FLATBENF screen for integrating with social security 

using the offset design.  
 

o Review Online Help or DB Reference Manual for details on these options. 
 

• Benefit Description 
 

o For traditional DB benefit formula types (UNITBENF, FLATBENF, ETC), there is an option 
to input a customized benefit description for the Summary of Plan Provisions report 
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#8 – Traditional Benefit Formula Coding 

 
B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ General \ Benefits \ UNITBENF screen 

 

 
Plan Specification: General \ Benefits \ UNITBENF screen 

 
o Generally, to be used with Accrual Types of Unit Accrual  

 
o Pct of Comp and Dollar Amt  

 
 Standard benefit formula options 

 
o Pct of Excess and Excess over 

 
 Used for integrating with social security 

 
o Maximum Years 

 
 Used for limiting the number of years considered for the benefit formula 
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B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ General \ Benefits \ UNITBENF screen (Continued) 

 
o Red. Prior to Acc Excl Dt: (excerpt of the available options) 

 
 Based on Accrual Exclusion Date entered on General \ Identification \ ID screen 
 2 - All Years 

• All years before the Accrual Exclusion Date will be excluded from the 
benefit service but Reduced for Years Less Than begins at the original 
Starting Date 

 4 - Total (<=35) 
• Years before the Accrual Exclusion Date will be excluded from the 

benefit service reduction for application to the total benefit. A cap on 
benefit service of 35 years is applied from the original starting date. 

 5 - Fresh Start 
• Service for the above formula begins at the Accrual Exclusion Date. Any 

benefits coded in the individual’s record as additional benefits are 
added on to the formula benefit. 
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#8 – Traditional Benefit Formula Coding 

 
B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ General \ Benefits \ CARRBENF screen 

 

 
Plan Specification: General \ Benefits \ CARRBENF screen 

 
o To be coded in conjunction with the UNITBENF screen 

 
o Career Average formulas calculate the current accrual based on current compensation, 

rather than average, which is then added to the Prior Accrued Benefit 
 

o Credit Service Percentages  
 

 Can be coded for up to 10 levels for prorating the accrual for the year based on 
a range of hours 

 
o Date of Formula Change for Prior Unit Benefit 

 
 If a date is entered here, the above formula will be applied to final average 

compensation using service prior to this date. This calculated prior service 
benefit will then be added to the benefit calculated based on service after this 
date and the formula on the UNITBENF screen. 
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#8 – Traditional Benefit Formula Coding 

 
B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ General \ Benefits \ FORMBENF screen 
 

 
DB Plan Specification: General \ Benefits \ FORMBENF screen 

 
o Group Formula Tables are used when more than 1 formula is needed in a single plan 

 
o Benefit formula is set up in Table Maintenance and can be selected for the above 

assigned groups  
 

o Set Employee’s Basic Data \ NAME screen Principal Code to 1 through 9 or A to assign a 
benefit formula to them.   
 

o If an employee’s Principal code is set to Y or N then their benefit would be calculated 
based on the other benefit formula screens coded in plan specifications.     
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#8 – Traditional Benefit Formula Coding 

 
B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ Funding \ BENFORM screen 

 

 
Plan Specification: General \ Benefits \ BENFORM screen 

 
o By default, if the Years Certain and Percent to Survivor are blank, calculations will be 

based on a single life annuity for the normal form of benefits.   
 

o Enter a value into either of these fields to change the normal form 
 

o Changing the normal form will impact the factors used in the calculations 
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B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ General \ Compensation \ MINBEN screen 

 
Plan Specification: General \ Compensation \ MINBEN screen 

o Use for All Years, not just Top Heavy Years 
 

 No 
• The Minimum Percent is applied to top heavy average compensation in 

top heavy years only up to the Maximum Years 
 Yes 

• The Minimum Percent is applied to top heavy average compensation for 
all plan years (whether top heavy or not)  up to the Maximum Years 

 
o Offset to Benefit Applies to Minimum Only 

 
 Yes 

• For plans with offset benefits for participants, the system will apply the 
offset to the top heavy minimum benefit only 

 No 
• For plans with offset benefits for participants, the system will apply the 

offset to a participant’s total benefit. See Offset Applied after Top Heavy 
Minimum field below 
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B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ General \ Compensation \ MINBEN screen (Continued) 

 
o Minimum Applies to Non-Key Only 

 
 No 

• Provide top heavy minimum benefits to non-key participants only 
 Yes 

• Provide top heavy minimum benefits to all participants, key and non-
key 

 
o Offset Applied after Top Heavy Minimum 

 
 For plans with offset benefits, the coding in this field determines if the benefit 

offset is applied to determine the accrued benefit 
 The benefit offset is always applied to the projected and funding benefits  
 No  

• Limits the accrued benefit to the greater of a) the top heavy minimum 
benefit without the offset applied, and b) the plan formula benefit with 
the offset applied 

 Yes  
• Limits the accrued benefit to the greater of a) the top heavy minimum 

benefit after offset, and b) the plan formula benefit after offset 
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B. Setting Up Benefit Formula Screens (Continued) 

 
• Plan Specifications \ General \ Compensation \ MAXBEN screen  

 

  
Plan Specification: General \ Compensation \ MAXBEN screen 

o Starting Date 
 

 Defines the date from which the system will begin counting years of service for 
the above requirement 

 For plans that count years for the 415 dollar limit based on plan years of 
participation, enter 4 – BOY Entry 

 For plans that define participation for the 415 dollar limit as elapsed time or as 
anniversary years based on hours, enter 3 – Entry 

 
o Exc. Yrs < Eff Date 

 
 Enter Yes to exclude service before the plan effective date for all 415 purposes, 

including for the purpose of counting years of service for determining the 415 
percent of pay maximum limit.  

 Plans with Starting Date set to 3 - Entry or 4 - BOY Entry, who count all years of 
service from date of hire for determining the 415 percent of pay maximum 
benefit should enter No in this field. 

 
• Run Calculations > Valuation to update the results after setting up the benefit formula and 

participant records  
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples 

 
• Example 1: Flat Benefit with Front End Accrual 

 
o Plan Design: 80% Fractional Accrual with 25 Plan Years of Participations for Full Accrual 

where a year is 1,000 hours.  The 80% is reduced for participants with less than 25 years 

 
Plan Specification: General \ Benefits \ ACCRUAL screen 

o Plan Specification settings 
 

 Type of Accrual  
• Select 4 – Front End for fractional accrual method  

 Years for Full Accrual  
• Enter 25 years for the Full Accrual option 

 Starting Date 
• Select 4 – BOY Entry because accrual service starts the first of the plan 

year they entered the plan 
 Basis of Year  

• Select 2 – 1000 Hours for 1,000 hour accrual requirements 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 1: Flat Benefit with Front End Accrual (Continued) 

 
o Plan Design: 80% Fractional Accrual with 25 Plan Years of Participations for Full Accrual 

where a year is 1,000 hours.  The 80% is reduced for participants with less than 25 years 

DB Plan Specification: General \ Benefits \ FLATBENF screen 

o Plan Specification settings 
 

 Pct of Comp 
• Enter 80.0 for the plan’s 80% Pct of Comp benefit formula 

 Reduce for Years Less than 
• Enter 25 to reduce the 80% for participants with less than 25 years of 

total accrual service 
 Other parameters are set to match the ACCRUAL screen 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 1: Flat Benefit with Front End Accrual (Continued) 

 
o Plan Design: 80% Fractional Accrual with 25 Plan Years of Participations for Full Accrual 

where a year is 1,000 hours.  The 80% is reduced for participants with less than 25 years 
 

o Participant service and compensation results for the benefit formula as of 12/31/2020 

Employee: Basic Data \ DATE screen 

Employee: Basic Data \ COMP screen 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 1: Flat Benefit with Front End Accrual (Continued) 

 
o Plan Design: 80% Fractional Accrual with 25 Plan Years of Participations for Full Accrual 

where a year is 1,000 hours.  The 80% is reduced for participants with less than 25 years 

Employee: Basic Data \ ACCRBENF screen 

o Participant Accrued Benefit result for the benefit formula as of 12/31/2020 
 

 Factors 
• 80% of average compensation reduced for years less than 25  
• Years Accrued: 1 
• Total Accrual Years: 27 (max of 25) 
• Accrual Average Comp: 4,223.25 

 Accrued Benefit Calculation 
• 80% x Accrual Average Comp x (Total Accrual Years / Reduced Less Than 

25) x (Years Accrued x Total Accrual Years) 
• 0.80 x 4,223.25 x (25 / 25 ) x ( 1 / 25 ) =  135.14 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 2: Unit Benefit with Unit Accrual 

 
o Plan Design: 4% Unit Accrual per year of participation for maximum 25 years 

 
Plan Specification: General \ Benefits \ ACCRUAL screen 

o Plan Specification settings 
 

 Type of Accrual  
• Select 5 – Unit per Formula for unit accrual method  

 Years for Full Accrual  
• Enter 25 years for the Full Accrual option 

 Starting Date 
• Select 4 – BOY Entry because accrual service starts the first of the plan 

year they entered the plan 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 2: Unit Benefit with Unit Accrual (Continued) 

 
o Plan Design: 4% Unit Accrual per year of participation for maximum 25 years 

DB Plan Specification: General \ Benefits \ UNITBENF screen 

o Plan Specification settings 
 

 Pct of Comp 
• Enter 4.0 for the plan’s 4% Pct of Comp benefit formula 

 Reduce for Years Less than 
• Enter 25 to a maximum 25 years of total accrual service years 

 Other parameters are set to match the ACCRUAL screen 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 2: Unit Benefit with Unit Accrual (Continued) 

 
o Plan Design: 4% Unit Accrual per year of participation for maximum 25 years 

 
o Participant service and compensation results for the benefit formula as of 12/31/2020 

Employee: Basic Data \ DATE screen 

Employee: Basic Data \ COMP screen 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 2: Unit Benefit with Unit Accrual (Continued) 

 
o Plan Design: 4% Unit Accrual per year of participation for maximum 25 years 

 

Employee: Basic Data \ ACCRBENF screen 

o Participant Accrued Benefit result for the benefit formula as of 12/31/2020 
 

 Factors 
• 4% of average compensation per year up to 25 years 
• Years Accrued: 33 (maximum of 25) 
• Accrual Average Comp: 5,013.00 

 Accrued Benefit Calculation 
• 4% x Accrual Average Comp x Years Accrued (maximum of 25) 
• 0.04 x 25 x 5,013.00=  5,013.00   
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 3: Unit Benefit with Service Credit Before Effective Date  

 
o In ASC, limiting years to a specific date is called a Fresh Start 

 
o Review References at the end of this topic for FAQs on Fresh Start programming 

 
o Plan Design: $100 Unit Accrual with 5 years of service before Effective Date per year of 

participation for maximum 25 years 

 
Plan Specification: General \ Identification \ ID screen 

o Plan Specification settings 
 

 Exclude Service  
• Leave blank 

 Exclude Accrual Service 
• Enter earliest date on which service will be credited 
• Enter 1/1/2016 to provide up to 5 years of service prior to the plan’s 

Effective Date of 1/1/2021 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 3: Unit Benefit with Service Credit Before Effective Date (Continued) 

 
o Plan Design: $100 Unit Accrual with 5 years of service before Effective Date per year of 

participation for maximum 25 years 

 
Plan Specification: General \ Benefits \ ACCRUAL screen 

o Plan Specification settings 
 

 Type of Accrual  
• Select 5 – Unit per Formula for unit accrual method  

 Years for Full Accrual  
• Enter 25 years for the Full Accrual option 

 Starting Date 
• Select 2 – Plan Year because accrual service is permitted to start as 

early as the first plan year service will be credited  
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 3: Unit Benefit with Service Credit Before Effective Date (Continued) 

 
o Plan Design: $100 Unit Accrual with 5 years of service before Effective Date per year of 

participation for maximum 25 years 

 
Plan Specification: General \ Benefits \ UNITBENF screen 

o Plan Specification settings 
 

 Dollar Amount 
• Enter 100.00 for the plan’s $100 per year of service benefit formula 

 Reduce for Years Less than 
• Enter 25 to a maximum 25 years of total accrual service years 

 Reduce Prior to Accrual Exclusion Date 
• Select 5 – Fresh Start to permit service to be credited prior to the plan’s 

Effective Date 
 Other parameters are set to match the ACCRUAL screen 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 3: Unit Benefit with Service Credit Before Effective Date (Continued) 

 
o Plan Design: $100 Unit Accrual with 5 years of service before Effective Date per year of 

participation for maximum 25 years 

 
Plan Specification: General \ Compensation \ MAXBEN screen 

o Plan Specification settings 
 

 Days in First Year 
• Enter 1 to have the system calculate 1 year of 415 participation service 

as of the plan’s Effective Date 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 3: Unit Benefit with Service Credit Before Effective Date (Continued) 

 
o Plan Design: $100 Unit Accrual with 5 years of service before Effective Date per year of 

participation for maximum 25 years 
 

o Participant service results for the benefit formula as of 1/1/2021 
 

 
Employee: Basic Data \ DATE screen 
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#8 – Traditional Benefit Formula Coding 

 
C. Fractional Benefit, Unit Benefit, and Fresh Start Examples (Continued) 

 
• Example 3: Unit Benefit with Service Credit Before Effective Date (Continued) 

 
o Plan Design: $100 Unit Accrual with 5 years of service before Effective Date per year of 

participation for maximum 25 years 
 

 
Employee: Basic Data \ ACCRBENF screen 

 
o Participant Accrued Benefit result for the benefit formula as of 1/1/2021 

 
 Factors 

• $100 per year up to 25 years 
• Years Accrued: 5 (maximum of 25) 

 Accrued Benefit Calculation 
• $100 x Years Accrued (maximum of 25) = 500.00 
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#8 – Traditional Benefit Formula Coding 

 
D. References  

 
• FAQs 

 
FAQ 264: Coding a tiered formula 
FAQ 1022: Coding an integrated formula with unit accrual   
FAQ 826: Fresh Start - Coding a First Year Val with Accrual Service Prior to Plan Effective 
Date 
FAQ 847: Fresh Start - Coding a new formula with a prior frozen benefit 
FAQ 496: Fresh Start - Coding a wear-away formula 

 
• DB Reference Manual 

 
• Online Help 

o <F1> on keyboard to access online help for each employee or plan specifications field 
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#9 – Participant Reconciliation with Grids and Formulas 

 
Topic Roadmap 

A. Grids and Formulas Snapshot 

B. 5500 Schedule R – Lump-Sum Distribution Counts 
 

C. 5500 Participant Counts 
 

D. Reconcile Annuity Distributions 

E. How to Load Sample DB Formula File and Saved Grids to Your ASC System 

F. References 
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#9 – Participant Reconciliation with Grids and Formulas 

 
A. Grids and Formulas Snapshot 

 
• Any participant field viewable on the participant screens can be used with grids.  For ASC users 

not familiar with creating grids to view employee data, it is recommended to review the grid 
webcast, grid training videos, and other available documentation before working with formulas 

 
o See F. References for a listing of available resources 

 
o Formulas can reference plan specification fields by adding an S: before the Plan 

Specification field 
 

 Example: S:PLNYREND will reference the Plan Year End date on the Plan ID 
screen. 

 
o If formulas are added to a grid, those calculated results will display as a column in the 

grid 
 

o Grids and formulas can be used to reconcile participant fields   
 

 Depending on your reconciliation needs, different participant fields and 
formulas can be used to display the needed information  

 
• This top tip will apply a practical application of grids and formulas to reconcile participant fields 
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#9 – Participant Reconciliation with Grids and Formulas 

 
B. 5500 Schedule R – Lump-Sum Distribution Counts 

 
• In general, there are three ways to identify if a participant received a lump-sum distribution in 

the 12 months prior to the valuation date: 
 

o If their status code as of the prior valuation date was not P, but as of the current 
valuation date, it is P 

 
 P status code is for participants that have been paid out of the plan and no 

longer have benefits due 
 

o If there is a value in their Benefits \ SOLEPROP screen \ 1099R fields and their status 
code is not D, G, or R 

 
 Status codes D, G, and R are for participants receiving annuity payments 

 
o If they have cash balance distributions input on their Costs \ CASHBAL screen 

 
 CB distributions generally are nonrecurring payments 

 
• Using Grids and Formulas, we can see which participants may have taken a lump-sum 

distribution during the prior 12 months 
  

o With the above logic, the ASC DB SchR Lumps grid will count those participants 
 

 
ASC: Employee window 
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#9 – Participant Reconciliation with Grids and Formulas 

 
B. 5500 Schedule R – Lump-Sum Distribution Counts (Continued) 

 
• In the screenshot below, the grid includes these columns: 

 
o P this Yr Not Last 

 
 Participants’ preceding plan history record status code is compared to their 

current status code 
 If status this year is P, but prior year status is not P, then 1 is returned 

 
o Not InPay but Dist 

 
 If a participant has a gross distribution input but status code is not DGR (retiree 

status codes), then 1 is returned 
 

o CB Dist 
 

 If a participant has a CB distribution input, then 1 is returned 
 

• Set View / Grid / Show Totals to Yes\Disallow Edits to show the totals for each column 

 
ASC: Employee: View of ‘ASC DB SchR Lumps’ 

 
• Depending on how you use ASC, select the participant results that you determine are 

appropriate 
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#9 – Participant Reconciliation with Grids and Formulas 

 
B. 5500 Schedule R – Lump-Sum Distribution Counts (Continued) 

 
• The formula used for the columns 

 
o P this Yr Not Last 

 
 $IF(S:FMBOYVAL="N";$IF((HSPARTST[HSDATE=@LastYear]<>"P")AND(PARTSTAT

="P");1;0);$IF((HSPARTST[HSDATE=@2YrAgo]<>"P")AND(PARTSTAT="P");1;0)) 
 

o Not InPay but Dist 
 

  $IF((DISTGROS>0)AND($NOT($IN(PARTSTAT;"D";"G";"R")));1;0) 
 

o CB Dist 
 

  $if(CBDIST > 0;1;0) 
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#9 – Participant Reconciliation with Grids and Formulas 

 
C. 5500 Participant Counts 

 
• 5500s report various participant counts.  For Example, line 6h is for the number of participants 

that terminated during the year that were not fully vested.   
 

• Formulas files can be created using ASC’s Utilities > Wizards > Formulas menu 

 
Utilities > Wizards > Formulas menu 

o The following formula could be added to a formula file to be used with grids for 
checking for participants that terminated during the year were not 100% vested. 

 
Utilities > Wizards > Formulas menu > ‘Termed<100%Vst’ Formula 

 Depending on the valuation date (BOY versus EOY), the ‘Termed<100%Vst’ 
formula references different plan specification fields for the 12-month period 
before the valuation date for reporting 
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#9 – Participant Reconciliation with Grids and Formulas 

 
C. 5500 Participant Counts (Continued) 

 
• For this presentation, the following generic formulas were used to calculate: 

 
o Active BOY, Enter on BOY, Enter During the Year, Active EOY 

 
o Retired During Yr, Retirees as of EOY 

 
o Terminated during the EOY, EOY Vested, Terminated <100% vested 

 
o Participants BOY and EOY 

 
ASC: Employee: View > Grid 

• At the bottom, when Show Totals Yes/Disallow Edits is enabled, totals in each category are 
calculated 
 

• Note, for this large of a plan, it takes a few seconds to View / Grid / Copy to Clipboard to process 
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#9 – Participant Reconciliation with Grids and Formulas 

 
D. Reconcile Annuity Distributions 

 
• Use Grids to calculate estimated individual annual benefit payments. Calculating estimated total 

annual benefit payments may help verify trust accounting or 5500 reporting 
 

• The following formula multiplies the Accrued Benefit by how many months the participant was 
retired in the 12 months prior to the valuation date 

o $RND($MAX($IF(S:FMBOYVAL="N";$MIN($CMO(RETIRE;S:PLNYREND);12);$MIN($CMO(
RETIRE;S:PLNYRBEG);12));0)*ACCRBENF;0) 

 
• After the formula file is saved, it can be accessible to a grid as a column by pressing the 

Formulas button. 
o If no formula file has recently been selected, you will be prompted to open a formula 

file 

 

o Double-click to add the formula to the grid.  

 
ASC: Employee: View > Grid > New or Edit 
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#9 – Participant Reconciliation with Grids and Formulas 

 
D. Reconcile Annuity Distributions (Continued) 

 
• To filter which employees are included in the Grid, press Select EEs to define the filter 

 
ASC: Employee: View > Grid > New or Edit 

o For retiree benefit payments, select codes of DGR. 

 
ASC: Employee: View > Grid > New or Edit > Select EE… 
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#9 – Participant Reconciliation with Grids and Formulas 

 
D. Reconcile Annuity Distributions (Continued) 

 
• After the grid is created, enable Show Totals to view the estimated total annuity benefit 

payments for the last 12 months. 

 
ASC: Employee: View > Grid 

• While creating the grid, if totals were enabled for that column the total will show at the bottom 
of that column 

 
ASC: Employee: View > Grid 

• For this plan, based on the coding of the employee records, it is expected that 545,608.56 
annuity benefits were paid in the prior 12 months from the trust.   
 

• Discrepancies between trust reports and ASC grid results can be reconciled outside of ASC.  
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#9 – Participant Reconciliation with Grids and Formulas 

 
E. How to Load Sample DB Formula File and Saved Grids to Your ASC System 

 
• Navigate to the Client Support Center / DOCUMENTS / ASC System webpage. 

 
• Download ASC DB Advanced Formulas and Grids.zip from the Client Support Center 

 
o The formulas provided are generic and may need additional logic added to 

accommodate your plan designs.  We welcome and will collect feedback on these 
formulas and grids for a potential future re-release. 

o Review the results to ensure they are as expected. 
 

• Review the instructions included in the zip file 
 

• Save the AdvancedFormulasDB-2021.FME and the included .GRX files to your ASC \ USER 
directory 

 
• Open a DB Plan in ASC.  After opening a grid that uses a formula, the following menu will open 

 
ASC: Employee: View > Grid > Open 

 
• Select the AdvancedFormulasDB-2021.FME file for use with the ASC provided grids by selecting 

the spyglass and navigating to that file.  

 
ASC: Employee: View > Grid > Open 

 
• After pressing OK, the grid will be displayed using the formulas.  
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#9 – Participant Reconciliation with Grids and Formulas 

 
F. References 

 
• Client Support Center 

 
o System Training > Web Seminars > General System 

 
 Grids & Formulas webcast 

 
o System Training > Web Seminars > Defined Benefit 

 
 DB Top Tips – 2020 

• DB Top 10 Tips – 2017 webcast, Top Tip #3 – Using Grids and Formulas 
 

o System Training > Web Seminars > General System 
 

 Grids & Formulas webcast 
 

o System Training > Training Video Series > Defined Benefit video  
 

  Grids and Formulas segment 
• Click on the menu button on the bottom right to select the Grids and 

Formulas segment as indicated with the red arrows below. 
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#9 – Participant Reconciliation with Grids and Formulas 

 
F. References (Continued) 

 
• Client Support Center (Continued) 

 
o FAQs 

 

FAQ 37: Grid--creating a formula to be displayed in a grid 
FAQ 5: Grid - Showing totals on a grid 
FAQ 337: Grid--Open a grid with the totals already turned on 
 

• Grid Manual 
 

o Formula Expressions 
 

o Using Formula Expressions with the Grid 
 

o Formula Names 
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#1 – American Rescue Plan Act of 2021 

#2 – One Participant DC Cash Balance Plan Proposal 

#3 – ASC-715 Basics in ASC 

#4 – Participant Termination/Optional Forms 

#5 – DB Pattern Plans Overview 

#6 – Extended History 

#7 – Average Compensation Overview 

#8 – Traditional Benefit Formula Coding  

#9 – Participant Reconciliation with Grids and Formulas 

 

Thank you for joining us! 
 

ASC - Actuarial Systems Corporation 183



  
  

Cumulative List of ASC DB Top Tips Webcast Topics 

Tip # 2021 2020 2018 2017 2016 

1 American Rescue Plan 
Act of 2021 

Changing Valuation 
Dates 

 Starting Dates for 
Benefit and Valuation 

Calculations 
 Housekeeping 

 Coding and Valuing 
Postponed Retirees 

UPDATED 2020 

2 
One Participant DC 
Cash Balance Plan 

Proposal 

Coding Postponed 
Retirees  Status Codes Overview  FASB / ASC  

 Using the new SOA 
Mortality Tables and 

Generational 
Projection Scales 

3 ASC-715 Basics in ASC CARES Act for DB Plans  
 Application of IRC 415 

Limits and Annuity 
Substitution 

 Using Grids and 
Formulas 

 Cash Balance 
Assumptions Coding 

Tips 

4 
Participant 

Termination/Optional 
Forms 

Using Force All Benefits  New PPA Report 
Enhancements 

 Combined DC/DB 
Participant Statements 

 Discounted Receivable 
Contributions for EOY 

Valuations 

5 DB Pattern Plans 
Overview 

Exporting Plan 
Specifications with 

ASCRIPT 

 Compliance Testing for 
BOY DB and EOY DC 

Plans 

 Schedule SB 
Attachments  Employee Statements 

6 Extended History Importing Plan Specs 
from DGEM Documents  Takeover Plans  New PPA Report 

Options 
 PBGC Premium Report 

Additions 

7 Average Compensation 
Overview 

At-risk Coding for 1st 
Year Cash Balance 

Plans 

 Checking Individual 
Calculations 

 Quarterly Contribution 
Reports 

 Using Reporter to 
Customize an ASOP 

Disclosure 

8 Traditional Benefit 
Formula Coding 

Plan Term/Optional 
Forms Enhancements 
for Cash Balance Plans 

 SB Attachment 
Reporting 

 IRC 401(a)(4) 
Component Plan 

Testing 

 Optional Forms 
Calculation of 415 

Lump Sums 

9 
Participant 

Reconciliation with 
Grids and Formulas 

Interest Rate Basics for 
Cash Balance Plans 

 Short Plan Year 
Programming and 

Reporting 

 DB/DC Combined Plan 
Reporting  Potpourri I 

10 NA ASC Defined Benefit 
Learning Resources 

 Importing Tables in 
Table Maintenance 

 Short Plan Year 
Programming and 

Reporting 
 Potpourri II 

Updated 2021 
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Cumulative List of ASC DB Top Tips Webcast Topics 

Tip # 2015 2014 2013 

1  New Cash Balance 
Formula Options 

 Exporting and 
Importing Portable 

Copies 
Coding tiered formulas 

2 
 Allocation of DB 

Contribution on DC/DB 
Combo Report 

 Status codes overview 
UPDATED 2018 

Coding the ANCILELG 
screen 

3  401(a)(4) Rate Banding  Takeover Plans – 
UPDATED 2018 

Checking Individual 
calculations 

UPDATED 2018 

4  PBGC Report for 2014 
and Beyond 

 Plan Termination / 
Optional Forms 

Employee statements 
UPDATED 2016 

5 
 Present Value and 
Benefit Comparison 

Reports 

 Data and Plan Specs 
Checking 

Average compensation 
UPDATED 2021 

6  SB Information Report 
Additions 

 Using Grids for 
Checking 

Application of IRC 415 
limits 

UPDATED 2018 

7  PPA Cushion 
Calculations 

 Quarterly Interest 
Program              

UPDATED 2017 

Annuity substitution 
UPDATED 2018 

8 
 Coding Postponed 

Retirees 
UPDATED 2020 

 PBGC Changes Preview Status codes overview 
UPDATED 2018 

9 
 New Omit Pre‐Entry 

Compensation 
Calculations 

 HATFA Updates DC/DB combo plan 
report 

10  Weekly Patches and 
Monthly Segment Rates NA Funded status report 

Updated 2021 
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